
QVT/Net 4.2
May 1999 Release

QPC Software is pleased to introduce the release of    QVT/Term 4.2, a suite of Internet tools and utilities. 
Included in this suite are:

 Telnet/rlogin client
 FTP client and server
 Internet Mail and News client
 SMTP and POP3 servers
 Lpr client and server
 Web client

The present release, 4.2, is an update release that introduces a set of enhancements and bug-fixes, as 
described below (see 'Release Notes').

Installation Notes

New Directory Structure

QVT/Net 4.2 uses a directory structure that is different from that used by prior releases. Here is the list of 
directories created by QVT/Net, along with their functions:

\bin Program executable files
\help On-line help files
\system Fonts, DLL’s and OCX’s
\terminal Data files used by the telnet/rlogin application
\mail Data files used by the mail client
\news Data files used by the news reader
\ftp Data files used by the FTP client
\ftpd Data files used by the FTP server
\popd Data files used by the POP3 server

All of the subdirectories reside one level below the primary QVT/Net installation directory, which is 
specified early in the setup process. The default installation directory is “C:\Program Files\QPC\QvtNet”.

Personalized Data Directories

During the QVT/Net setup, you are asked whether or not QVT/Net data is to be "personalized", or kept 
separate on a per-user basis. This option, for which the default is "YES", involves storing data in 
subdirectories below each of the application-specific subdirectories, not in the application subdirectories 
themselves. For example, if a user named "smithj" logs in to the PC, a subdirectory "smithj" will be 
created for that user in each of the application subdirectories.



Upgrade Issues

If you are upgrading from an earlier release of QVT/Net you will have to move your data files from the 
"bin" directory, where these files were formerly kept, into the appropriate application subdirectory.

This personal subdirectories will be created by each QVT/Net application the first time you start it up. 
The easiest procedure is therefore:

1. Launch the application
2. Launch Windows Explorer
3. Locate the newly-created user subdirectory below the application subdirectory
4. Navigate to the QVT/Net "bin" directory
5. Move application data files to the appropriate application-specific directory:

In the next series of items, replace “user” with your Windows username:

 The files TERM.CFG and TERM.MRU, plus any .KM files and .SCF files should be moved to 
“terminal\user”

 The files “ftphosts” and FTP.MRU should be moved to “ftp\user”
 The files “ftppass” and QVTNET.ACL should be moved to “ftpd\user”
 The files QVTMBOX.RC, QVTALIAS.RC, QVTMAIL.MRU, QVTMAIL.RTE, and QVTMAIL.SIG

should be moved to “mail\user”

Separate Program and Data Directories

Note also that QVT/Net 4.2 allows you to specify different root directories for program files and data 
files. This is intended to facilitate the sharing of QVT/Net configuration data among users who operate 
from a common file server. The "Terminal" subdirectory discussed above will be located in the DATA 
directory that you specify at setup time, which may be different from the program file directory.

For example, you may specify that QVT/Net should be installed into the default directory, "C:\Program 
Files\QPC\QVTNet", and that the data files should be installed into "E:\QVTDATA". In this situation, the 
"Terminal" subdirectory, and all other application-specific subdirectories, will be located below "E:\
QVTDATA".

Caution: the QVT/Net 4.2 directory structure is documented in the Windows registry at install time. 
Therefore, you cannot move any of the QVT/Net files after they are installed. The applications will 
almost certainly not work if they are not run from their original locations.

New Silent Installation Option

You can now install QVT/Net "silently"; i.e., without any prompts or user interaction. This is done by 
running SETUP.EXE from the DOS prompt, with the "-S" switch:

C>SETUP -S

The setup will proceed according to the responses stored in the file SETUP.ISS. The most important piece
of information in this file are the names of the installation directory and data directory. If you wish to 

ftp://FTP.MRU/


install QVT/Net in a different location, you should edit SETUP.ISS before running the silent installation.

Registration Information

The registration fee for QVT/Net 4.2 is $40US, plus $5 for shipping.

To register, please send your check or purchase order to:

QPC Software
P.O. Box 226
Penfield, NY 14526
USA

QPC accepts Visa, Mastercard, and American Express. To order by credit card, we will need your card 
number and expiration date.

Volume discounts and site licenses are available.

Contacting QPC

You can reach QPC Software at these telephone numbers:

(716) 381-4610 (voice)
(716) 381-1215 (fax)

QPC can also be reached via email:

robin@qpc.com (Sales inquiries)
support@qpc.com (Technical inquiries)

To check if you have the latest release of QVT/Net, check our Web site:

http://www.qpc.com

All QVT/Net applications are designed to be powerful, efficient, reliable, and easy to use. If you 
encounter a bug, or if you have a suggestion that you believe will improve the product, please send email 
to support@qpc.com with your recommendations.



Notes on Release 4.2d

 FTP server: passwords and home directories are now stored in the registry, rather than in the 
“ftppass” file. As a result, user accounts must be rebuilt manually.

 Terminal: A new menu item has been added that allows you to update the default configuration values
for screen size and position, font, and color scheme, using current values.

 Terminal: printer device settings (e.g. portrait/landscape) will be stored across print jobs within a 
session.

 Terminal: all printer-related menu items have been collected together under the “Printer” pull-down 
menu. Some items are duplicated elsewhere.

 Terminal: support for the NumLock “forced on” mode has been restored when running under 
Windows NT.

 FTP client: SOCKS support has been reinstated.

 Mail/News: a new text/HTML control is employed in this release. The new control allows you to 
select text and paste it to the clipboard, using standard techniques.

Notes on Release 4.2

This is a partial list of the changes and enhancements contained in the 4.2 release. More items will be 
added to future editions of this release note.

 The "Printer Dialog Error 4107" problem has been fixed in QVT/Term. This error, which occurred if 
the QVT/Term default printer was removed from the system, is handled by falling back to the 
Windows default printer if the QVT/Term default printer cannot be found.

 You can now specify that QVT/Term should always use the Windows default printer, and not attempt 
to keep track of its own default printer.

 You can now specify that QVT/Term should not prompt before the first print job in a session. If this 
option is selected, printing will begin immediately, using the available default printer.

 A limitation on the ability to select fonts which employ scripts other than "Western" has been 
removed.



 QVT/Term script files now use the extension ".QSF", instead of ".SCF", which belongs to the 
Windows operating system. Backward compatibility has been preserved, however; existing scripts 
which use the extension ".SCF" will continue to be recognized.

 The "printer" toolbar icon now performs a "print screen" function, as opposed to toggling "auto print"
mode.

 The "Print Setup" and "Print Screen" functions have been moved to the "File" menu.

 QVT/Term will now return from a scrolled-back state immediately following any keystroke, not just 
the <Esc> key. In addition, if the key pressed represents ordinary data, it will be transmitted to the 
host, rather than "eaten" by QVT/Term. This revised behavior is in accordance with published user-
interface standards for Windows applications.

 The SOCKS setup page has been reinstated to the QVT/Term “Default Settings” dialog. This is to be 
used if you communicate through a SOCKS firewall.

 You can now email QVT/Term screen images, using the new "Screen Image - Mail" menu item. You 
must provide a recipient email address, subject line, a return address, and the name of an SMTP mail 
gateway.

 You can now indicate that QVT/Term windows should be resizable or non-resizable. The latter is 
useful in situations where it is important to maintain a certain window size for reasons of host 
application compatibility (some host applications don't run will in non-standard window sizes). This 
option will be found in the "Default Settings" dialog.

 If a QVT/Term connection takes more than a couple of seconds to complete, a status window will pop
up, indicating the pending connection. This window also contains a “Cancel” button, that you can use 
to abort the connection attempt.

 A “Print” icon has been added to the FTP client main screen. You can use it to print files from either 
the local or remote filesystem

 The Mail and News clients have been combined into a single application

 An lpr daemon has been added to the QVT/Net suite

 A POP3 server has been added to the QVT/Net suite

 A command-line utility for sending email has been added

 The method used by the FTP server for storing username/password information has been changed. As 
a result of these changes, it will be necessary to reconstruct any existing database manually.

 Some changes have been made to the FTP client for the purpose of increasing throughput.

 The FTP server will now report the IP address of the remote system as soon as a connection request is
made. This will allow you to identify possible attacks on your PC.



Notes on Release 4.1.5c

 The Default Settings setup page now includes a selection labelled 'Resize Action'. This allows you to 
specify how QVT/Term will behave when the application window is resized. There are two possibilities: 
either the display area will change (different number of rows and/or columns), or the font will rescale to 
fit the new window size, while retaining the same number of rows and columns. Please note that this logic
applies only if a TrueType font (e.g. DEC Scalable) is selected. If a fixed-size bitmap font is selected, the 
display area will always resize, and the character size will remain the same. Note also that pressing and 
holding the <Ctrl> key while resizing will select the opposite of the default resize mode. For example, if 
the default resize action is 'Window', pressing and holding the <Ctrl> key while resizing will cause the 
font to resize instead of the display area.

 The high bit of any outgoing character can be set by pressing <Ctrl+Alt> together with the character.

 When scrolling through the scrollback buffer using the scrollbar 'thumb', the window contents will 
now scroll in sync with the mouse.

 The list of configurations in the 'Open Session' dialog is now sorted. Also: the default configuration 
does not appear in the list. Instead, the default configuration is selected using a dedicated radiobutton.

 The 'xterm' escape sequence for setting the window title is now supported. This escape sequence is 
formatted as follows: <Esc>]2<window title>\007, where <Esc> represents the ESC character (\033), and
\007 represents the ASCII character 7 (BEL).

 Both the name and mode of the default printer are now saved. This means, for example, that 
landscape mode, once selected, will remain in effect until a different mode is selected. You will be 
required to select a printer and a print mode for the first print job of a QVT/Term session, but the selected 
settings will remain in effect for the remainder of the session.

 There is now more extensive error reporting if errors occur during printing.

 A bug has been fixed which was causing the 'hosts' file to be written incorrectly.

 When a new configuration is saved, the list of configurations that is shown in the 'Open Session' 
dialog will be updated.

 A bug has been fixed that was causing print jobs that use 'overprint' to come out incorrectly.

 Since the DEC terminal assigns no useful defaults to the first four 'F' keys, QVT/Term now uses these
keys to 'double' the functions of the four 'PF' keys. This should be useful in situations where the physical 
mapping of the 'PF' keys is awkward or user-hostile.

 QVT/Term now supports the transmission of 8-bit characters, by pressing <Ctrl+Alt> together with 
the character whose 8-bit version you want to send. For example, to send the 8-bit (i.e., high-bit set) 
version of the character 'A', press <Ctrl+Alt+A>. Note, however, that some telnet daemons will filter out 
the high-bit.

 In some circumstances, the print functions would generate an extra page at the end of the print job. 



This bug has been fixed.

 QVT/Term will now respond to mouse clicks during a data 'flood'.

 A bug in the handling of the 'Save Hosts' function has been fixed.

 The modem dialing method (tone or pulse) is now user-selectable.

 A bug in the layout of the 800x600 DEC Fixed font has been fixed. This bug caused some 
discrepancies in the cursor position when in 132-column mode.

CAC 11/24/1997

Notes on Release 4.1.4

 The ability to specify a 'default printer' has been restored. This capability was dropped in release 
4.1.2, and is restored in the present release.

 Certain non-printing characters in the high half of the DEC Multinational Character Set are now 
being ignored, as they should. Previous releases allowed them to pass through, which resulted in the 
display of anomalous characters.

 Handling of the <Ctrl+Break> key combination under Windows NT 4.0 has been fixed.

 Maximizing the screen while in 80-column mode will leave the logical screen width unchanged, even 
though the physical screen width changes. In 132-column mode, the logical screen will adapt to the 
physical screen (always maintaining a minimum of 132 columns).

 The 'onscreen' script command has been fixed.

 In the 'Current Settings' setup dialog, the selection of 'LF' as the newline character will now be saved 
correctly.

 The syntax for initiating a DDE conversation with a QVT/Term window has been changed. Instead of
using the configuration name alone as the DDE topic, you must now use the configuration name together 
with the session number, separated by a colon. For example, if the QVT/Term window that you want to 
connect to is using the default configuration, and the session number is 1, then the DDE topic will be 
'default:1'. The configuration name is the label that appears between square brackets in the title bar; the 
session number is the number that appears in parentheses just to the left of the configuration name.

 The rules which apply to the naming and placement of keymap files and script files have been 
tightened. Beginning with version 4.1.4, all keymap and script files must reside in the \QVTNET\BIN 
directory. All keymap files must have the extension ".km", and all script files must have the extension 
".scf". When you are prompted to name a keymap file or script file, please supply only the 'root' portion of
the name. Omit the directory and extension; they will be supplied by QVT/Term.

 Some menuitem shortcut-key assignments have been changed. This was done to prevent menuitems 



from being inadvertently activated.

 When dragging the mouse leftward to select text, you can now select all the way to the leftmost 
character in the window.

Notes on release 4.1.2

 Some problems have been fixed in the handling of 'full-screen' mode as the default mode.

 Performance and reliability of the printing functions has been improved.

 A 'captive mode' option has been added. This disables most menu options, and allows the 
presentation of a controlled environment to the user. Please email me (chloe@qpc.com) for instructions 
on how to enable this mode.

Notes on release 4.1.1

 The default custom font can now be a 'Bold' font.

 At startup time, the absolute size of the Terminal window will be retained even if it overflows the 
available screen area.

 A scrolled-back display will now be returned to the 'home' position at the first keystroke. 
However, that keystroke will not be transmitted to the host.

 The status bar will now redraw correctly after a window resize.

 All of the QVT/Term-specific DEC fonts are now installed into the Windows environment at 
setup time. This will do away with the need to place the font files in any particular directory, and will 
ensure that the fonts can always be found, even if QVT/Term is launched from within another application 
(e.g. Netscape).

 QVT/Term will not react improperly to repeated 'close' or 'fail' messages from Winsock.

 A 'Slow Paste' option has been added to the 'Edit' menu. This is for use in cases where the host 
system cannot accept pasted characters at full speed.

 The trailing '/', if present, will be dropped from telnet URL's before final interpretation.

 The 'View' menu has been expanded. Items have been added to allow quick access to the screen 
width (80/132) and display mode (window/screen).

 The VGA-res 132-column font has been widened from 4 pixels per character to 5. This will 
significantly improve the readability of the 132-column display. As a result of the added character width, 
only about 128 columns will actually be visible; horizontal scrolling will be needed to view the rightmost 



columns.

 The 'paste' function now works correctly within the context of a 'local-echo' telnet session.

 Support for the MS LineDraw font (LineDraw.ttf) has been added. If you have this font on your 
system, you can select it for use as a 'custom' font, and QVT/Term will employ the line-drawing 
characters where needed.

 A problem with printing to HP LaserJet 4 printers has been fixed. The problem occurred when 
performing a series of screen-prints; the second and all subsequent screen-prints would appear as a solid 
black rectangle.

 When performing host-directed printing, the printer device context is set to 'transparent', which 
allows the use of overstrike techniques to produce underlining on line printers and matrix printers.

 Previous versions of QVT/Term 4.x had trouble calculating the window size in a Windows 95 
'Large Fonts' environment. These problems have been eliminated in release 4.1.1.

 The 'answerback' feature now works correctly.

 Resizing the window in a 'full-drag' environment will no longer trigger a rapid series of repaints. 
Instead, a single repaint will be performed with the resize is finished.

Notes on Release 4.1

 All applications now use the Windows Registry as a repository for setup information. This means 
that you will have to re-do the initial setup on all of the applications. Also, a couple of setup values are 
now shared among several applications, most notably those having to do with sending email (SMTP host, 
email address). These values can be modified only by the 'Mail' application. Therefore, we recommend 
that you start QVT/Mail first, in order to take care of these important setup tasks.

 We have added a new 'DEC Scalable' font, and dropped the 'DEC Small' font. The DEC Scalable font 
is available in sizes ranging from 8pt to 16pt. You can have 24x80 windows of almost any reasonable 
size, using the built-in point sizes. In addition, you can create new sizes 'on the fly' by pressing and 
holding the <Ctrl> key while you resize the window. This method can be used not only with the new DEC
Scalable font, but with any TrueType font. Note, however, that these non-standard character sizes cannot 
be saved for later use (at least not in the present release).

 The menu bar has been reorganized for easier access to the various sections of the 'Setup' menu. 
There are now separate submenus for Keymaps, Printer, and Font setup.

 You can now specify a default download directory as part of the 'Default Settings'. This will be the 
initial target of Kermit downloads.

 By default, if you try to close a Terminal that contains a 'live' session, you will be prompted for 
confirmation before the window is closed. This confirmation prompt can now be defeated, by deselecting 
the checkbox labelled 'Confirm Disconnect on Close', which appears on the 'Connectivity' setup page 
(Default Settings only).



 Some bugs in the printing function have been fixed.

 A new statement - "password" - has been added to the script language. This is for use in situations 
where it is undesirable to store passwords in script files.

 A new statement - 'onscreen' - has been added to the script language. This statement allows you to 
search for a string on the screen.

 A new dedicated color is provided for use with the 'reverse video' attribute. This color will be used 
instead of the default 'foreground' color as the background for reverse-video characters. Characters that 
are displayed as high-intensity reverse video will still use the dedicated 'bold' color as the background.

 The Terminal and FTP client applications will now accept URL's as command-line arguments. At a 
minimum, the host name given in the URL will be accepted as the host for the new session. Any 
additional information, such as username and password, will be used as well. Note that only fully-formed 
URL's will be accepted; i.e., the protocol must be present in the URL as the first portion of the string. 
Note also that, in the Terminal application, a valid default login prompt and password prompt must be 
provided; see the 'Default Settings' setup dialog.

Notes on Release 4.0.5

 A 'View' menu has been added, which allows you to selectively hide or show various window 
elements, such as the toolbar and status bar.

 Support for the 'blink' attribute has been added.

 A 'severity' statement has been added to the script language. By issuing the statement 'severity 
continue' at the beginning of a script, you allow the script to continue even if a timeout occurs on a 'wait' 
statement (the default behavior is for the script to abort). This in turn allows the use of a 'goto' statement 
to modify the flow of a script depending on whether a 'wait' succeeds or fails. The two flavors of 'goto' are
'if_err_goto' and 'if_noerr_goto', which can be used as appropriate to the situation. The target of a 'goto' 
must be a label, which is a line consisting of the label text preceded by a colon (':'). This format is the 
same as that used in MS-DOS batch files.

 A 'homedir' directive has been added to the [defaults] section of TERM.INI. The value of this 
(optional) directive will be the name of the directory where TERM.CFG and other files of this type are 
stored. By placing TERM.INI in the \WINDOWS directory, and including a 'homedir=' statement, you 
can assure that QVT/Term will be able to find its configuration files even when launched from within a 
Web browser (rather than from a Win 95 'shortcut').

 The window-resizing functionality has been enhanced, to take account of situations where you want 
to change the font size, not the number of displayed rows and columns. To apply this feature, press and 
hold the <Ctrl> key while you are resizing the window. When you terminate the resize operation, the font 
size will be changed to fit the new window size. Note: this feature is available only when using TrueType 
fonts. You can select a TrueType font via the toolbar font selector. QPC will be providing a TrueType 
DEC terminal font in the near future.



 Some bugs in the display of ANSI color text have been fixed. Colored text should now be easier to 
read, and some problems with screen corruption have been fixed.

 Some problems with transparent printing have been fixed.

 The 'Save Hosts' command has been added to the 'File' menu. This allows you to update your 'hosts' 
file with names that are obtained during terminal sessions.
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